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IF YOUR FLASH DRIVE DATA IS STILL GETTING CORRUPTED

After going to My Computer, Right dick the Removable drive, Go to
Properties >Tools. Run Error Checking and Scan for errors and fix them.
The files that are corrupt or in bad sectors already will not work but at
least tha new transferred files should work

Goneral | AutoPlay | Tools | Harswars | Shamng
| Erorcheciing
& Thia option wil check the valume for
o

IF ALL FAILS, FORMAT YOUR DRIVE.

It will delete all the data from your USB drive and make it fresh and
hopefully remove all errors. The software for formatting comes on the CD
or available on support sites for your branded usb drive on the net. For
some reason, when [ ran this formatting softwara, it would say the USB
drive is not connected,
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A= Internet Explorer Fix
About

Internet Explorer Fix - Windows [All]
Descrphion about thes lood
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RegSvr32 \ 1. Scipt En st % in Intemet Explores
2 When @ hypesink in an e-mal meszage or on a Web page.

you chick,
urd'l-ekkchw‘rkma\\‘obmarmmm “Open in How
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.
\lf) DlRegisterServer in ole32.dll succeeded.

& Nething happens
b. The new window may be blark

<. 'Vou may receive a scEpENg N message
3 When you use the Print command o the Print Preview command in
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Er%msm
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-
9 | J DlRegisterServer in iepeers.dil succeeded.
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How to Back Up the Registry in Windows 98 and
Windows Millennium Edition
Miew products that this article sopbes to,
This article was previously published under Q256419
Article 1D : 256419
SUMMARY Last Review | January 27, 2007

This article describes how to manually back up the Revision  :14
Windows registry using Windows Registry Checker
(Secanregw.exe).

MORE INFORMATION
There may be situations where you need to edit the Windows registry. Before you edit the
registry, you should make a backup copy of the registry using the following steps:
1. Click Start, chick Run, type scanregw, and then click OK.
2. When you receive a prompt to back up the registry, click Yes.
3. wWhen you receive the "Backup complete™ message, click DK. ]
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(A1) Explore
Search by NoClone. .
Search...

Sharing and Security...
Wadd to archive. ..
B add to “Archive.rar”
B Compress and emad. .,
B Compress to "Archive.rar” and emal

Format...

Copy

Create Shortcut
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Defrag cpdgqé

op§eosd opsqjom¢> Windows M E osdorEcondlonunHard disk o3copds defrag apbe§
§Aloncbi 533l ScanDisk o3 ap§qjonoen gEom 32§ §326005(030033208 o[B8 [gBesdl 0oudi
0€:8:6056 2300705 F{ep: 0§oqSondeean hard disk ¢o 32006 pes005ed 20cBe0sclonedi
315 09§05 (G308 s op apdcBadeoend defrag apdoyzedl op§q)omn0? sloppean 805
cB051{g§E8E:3055 32(03605 50l Defrag cpdedianpds 320050l omneoglgbor§omad
o8qpu

Scandisk §, Disk defragment cogq), a>6o0000000m 23034, cvbc§:o503 hard
disk driveeo 30056005 3209S0pSa3(030] 0005 3(E0:0§09602693 (030:(g05 0fapSom
Q:03 ecdcuniopialdleonni B8msl 0903crdesar crbesi05a3 Fomes (05(8: (pSood
(030100051 3 (03¢ GE:c08c§:05804]:03 SafeModesncySorn memnd:adicli sa(go:
0Qoqbeny madmmenypos ofaxnomng): e§eorclop:i

Safe Mode of oéQep Start mmeg Run... o3¢é1 msconfig a3(8: §aScopdolu
[6€mgc:0n65 eulamcladéenSi s38¢o General (tab) o3¢¢1 Advanced (button) o3
§5(8: Enable Startup Menu (checkbox) o3 eg:a3a5cli ego05 OK o3 mawd §6(036
[E)lcx?(c)@: oé:%:ogorc?’ @%G@oé:cf?’crg(ﬂ I 338 33] oé:%:ogoo 09[)(753005 egéemgoé Startup
Menu(géagé:eclancladéendi egondéolosed (o) Safemodead eg:oli egood <Enter>
§5c305q¢ oé:8:5056000 SafeModewo §egolouSn

Windows XPeo System Configuration Utility s§o3 (eSogé:§jzecTcloouSn Safe
Mode o %G@OOOS;@O’D 3309:30[395 $eogum YEYLL [g)org[;)orgcoo:ooo:eo?os)emgo’)
9§0l:0l:3031 6[mpSecaé (oQecy, qulecdi Start\RuN...o3 ¢&(8: scandisk o§ ewpod
sfc /scannow o §a5copgol OK o &6(8: o00S disk driveen scan cpdenSadorn
eg:qiuSol egoos Standard option o3 eg:(8: Start o mcos(gepS(gé(e¢ ScanDisk
03 ce008g0d&EalBn 3331(8:q¢ Through§, scan (geodclu

ScanDisk cpSc§:05(8:030:08 (o€ omeny [9¢a0c(8:q¢ Disk Defragmenter o3
(00968 onuSi gEzapog05 Start-Run... o defrag §odoops[8: OK 03850l egoas de-

Run @@

= Type the name of a program, Folder, document, or
.' Internet resource, and Windows will open it for you.

Open: ! sfe Jscannow| v |

[ OK ][ Cancel Jl Browse... J
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frag (gopdens hard disk driveo3 eg:q05([3: Disk Defragmenter coSc§:08 0@

8 ¥éc§ieny (G:030:q¢ 0€:8:603 [0§een:(8: Startup Menueo Normal o8 eupod

Start Windows normally o3 eg:g05(5S:(0¢ $9§ 0:3:005603 [0§capodegoladecdi

Safemodec(ood:§p5:03 ©qC:608:08, cenql ee:aé 605000051 cqradadc]eudi

WindowsAdvanced OptionsMenu
Please select an option:

SafeMode

Safe Modewith Networking
Safe Mode with Command Prompt

Enable Boot Logging

EnableVGA mode

Last Known Good Configuration (your most recent settings that worked)
Directory Services Restore M ode (Windows domain controllers only)
Debugging Mode

Start WindowsNormally
Reboot
Return to OS Choces Menu

Use the up and down arrow keys to move the highlight to your choice.

Microsoft Windows 95 Sartup Menu

1.Normd

2.Logged \BOOTLOGTXT)
3. Safemode

4. Step-by-step confirmation

5. Command prompt only
6. Safe mode command prompt only

Enter achoice: 1

F5=SafeMode
Shift+F5=Command prompt
Shift+8=Step-by-step
confirmation [N]
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fTrue'J'vpe (Tchme) 'Tr\x.f\-.xJ (TrueType) DemboidIt.. Dembold..,  Dtabc (Tr.. Reguar {,..  Unicode ..
a 4a 4 4 d d d 4 d a
Microsoft Sans MMyanmarl  Modem (Al Palatno Palating Palating Palatng Raad
(Tn mee] Sexif (TrueT... res) (Tn uel'me] Unotype... LinotypeB... LnotypeB... Unotypelt.. (TrueType)

QMQQQQQQQQ

Roman (Al Saript (All res) Sylfaen TahomaBold | TimesMew  TimesMew  Times New
(True

res) Type)  (TroeType) (T uTm] (TrueType)  (TrveType) | Roman (.. RomanB... RomanB...
21 o9 9 d J ol Q ol
TimesMew  TrebuchetMS TrebuchetMS TrebuchetMS TrebuchetMS  Tunga Verdans  VerdanaBold VerdanaBold Verdana Itskc
Roman it.. (TrueType) Gold (True... BokdItabc (... [tabe (True... (TrueType) (TrueType)  (TrueType)  Itale (Tru. (TrueType)
WOlArtHouse ‘Webdngs  WingDings rﬂnma WST, c:«m WST, EnthI WST, mn(u WST, Genn[-!-l \STJH(H
fl'meT\'pe] Win (True...  (TrueType) '!n.eT,veJ es) s} res)
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res) (Al res) ~
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03 ¢¢[B: eamndesd(gul fontsgpimagad oq§0m04p:03 (ecs36q<) deleteaySlospgoli

q$coxqupbfontsqp:

Arial, Comic Sans, Courier, Courier New, Marlett, Modern, MS Sans Serif, MS Se-
rif, Roman, Script, Small Fonts, Symbol, Tahoma, Times New Roman, Verdana,
Webdings and Windingso$, (¢(03(8: c:03¢ Bold, Italic, Italic and Bold gppzcopS:
oloolonudi ego05 FONT mqj:aa00: fontsasn:ad:s, s§eqpc 'A'aseodonolo) fonts
qp: 936005 MS§, Lucidacloy fonts gp: (9(30lonudn 88 qE:ap05c3 e 3a0
ocoqé Tahoma (fonts) gp:03 deletecyd(8: 32206 [9§0p3(03psoln

3203602059539 Edlooud
Shoutcut keys cogod og§eo’ elogpean 03::Clonudi 005602 6emp§ Clonudiol:3:63 0ag,
6807636095000583E0) Shortcut keys qp:o? esdjgeveocddlonddi

Shorteut keyseogs, 005000503 0R§q0qPs0S3, 2084100 003060340 vleay§ol]

051 200538 eqp 6509604, Helpanes Searchfor: a3 Shortcut o3 vopo5 Shorteut
key o8, §oda0pd(B: qpegdcolonudi wg shortcut keys qp:a3 saCorsadSeonssod
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Driving around your desktop
Usethisshortcut

F3

Select thefile/folder, click F2,

Select thefileg, right-click, and
then click Properties

Ctrl + Esc

Drag thefile/folder icon

Alt + Tab, then hold down Alt

Shortcut keys

Searchfor afilefolder

Rename afile and then re-type the name

folder
Find out when thefile or folder

was created, by whom, and how bigitis

Display the Start menu
Create a shortcut to your desktop on

your desktop to your favoritefiel/folder

Scroll between whileclicking Tab to reach

the open itmes desired file or program

Keyboardtips

Helpful keyboard shortcutsfor WindowsXP

Press the Windows logo key
Press the Windows logo key + L
Press the Windows logo key + E
Press the Windows logo key + M
Press the Windows logo key + F

to open the Startmenu.

to quickly switch betwen users.

to explore My Computer.

to minimizeall openwindows.

to open the Search window.

Press the Windows logo key + F1 to open Help.
Working with Word

Usethisshortcut To....
Shift+Right, Left, Up or DownArrow Select text

to highlight text

Ctrl+C Copy selected text
Ctrl +X Cut selected text
Ctrl+V Paste selected text
Ctrl+z Undo your last action
Ctrl +A Selected all thetext
Ctrl +B Boldtext

Ctrl +1 Itelicizetext

Ctrl +U Underline

Ctrl + Shift+< Decreasefont size
Ctrl + Shift +> Increase font size
Ctrl + Shift+F Change font

(then use the arrow keys to reach the new font)

Ctrl + Shift+P Changefont size
(then use the arrow keys to reach the new font size)

Ctrl + Enter Create page break
Ctrl +N Create new document

pRéqjomsseezacly
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Ctrl+0O
Ctrl +W
Ctrl+S
Ctrl+P
Clt+Ctrl +1

Accelerating Excel
Usethisshortcut

Tab

Enter

Backspace

Home

Ctrl +; (semicolon)
Ctrl + Shift +: (colon)
= (equal sign)

F7

ALT +' (apostrophe)
Ctrl +1

Ctrl +Shift +~

Ctrl + Shift+$

Ctrl + Shift +%

Ctrl + Shift +&

Open My documents window
Close adocument

Save a document

Print adocument

Preview what you're about to print

Moveright to left, cell by cell

Move up and down, cell by cell
Erasedatain current cell

Return to the beginning of the row
Enter the data

Enter thetime

Startaformula

Check the spelling of titles or wordswithin the cells
Find out about the style within the cell
Display the Format Cellsdial og box
Apply the general number format
Turn numbersinto dollars

Make numbers a percentage

Apply aborder

Windows OS @Soéqp:

oglpe0rd8elgboprmogiom008ehEanbeitenaanpbapddoncbiope sacpbapboiogio
¢ 0005800800308 eieomp Windows X Pa3elgdlocudn Service Pack 1 cons 2 conzed
6626027 990 0e[g8Edlopa opead omeagamseiesonadad[g§esdilonudingfeobcdewnise

0 3200050003 [§§ 635565030l ) qj[0m0e0:008e00HFesF 9005603 adie5000563
0 BBy Boozooonuded coédlonudi dlevend apead €38 ogseorboBbodaopds
©03Clon:[968E6 € 0&:8:b058e0x300/0pE:s 3epEO3G00CdN

N N o < N < N N N ’] QQ < ’] N
ODONVOONG: Saeoazoooee‘l:qqc QIO«?OD?’J 33@:%380(73396«?:?0 GS‘FQO QVEeWII 3 ?GU?U)

33:@0: @osﬁm&'ef)sae@% oqo%eoq(ﬂa%@eof)u 0wy 39093%@ e@%@cﬁ?ngo']m&n %o%m%

630764, 0€:3:0050 B§|:3200:q:4, E0E0Y 981 WO3ED a5Vl 303C: (goulorudH

- 1983 November
- 1985 November
- 1987 December
- 1987 December
-1988 June

Microsoft Windows
Microsoft Windows 1.0
Microsoft Windows 2.0
Microsoft Windows/386
Microsoft Windows/286

960 | opfqgjomsecezacly



-1990 May Microsoft Windows 3.0

- 1991 October Microsoft Windows 3.0a

- 1992 April Microsoft Windows 3.1

- 1992 October Microsoft Windows for Workgroups 3.1
- 1993 August Microsoft WindowsNT 3.1

- 1993 April Microsoft Windows

- 1994 February Microsoft Windows for Workgroups 3.11
- 1994 September Microsoft WindowsNT 3.5

- 1995 June Microsoft WindowsNT 3.51

- 1995 August Microsoft Windows 95

qé:()fc?) 9 61(73330858 G(YJ’S(O) o) OJ%:G(‘T{I’C) Gepé.q_léq&)é 1]

- 1996 August Microsoft WindowsNT 4.0

- 1996 November Microsoft Windows CE 1.0
- 1997 November Microsoft Windows CE 2.0

- 1998 June Microsoft Windows 98

-1998 July Microsoft Windows CE 2.1

-1999 May Microsoft Windows 98 SE (Second Edition)

-1999 Microsoft Windows CE 3.0

- 2000 February Microsoft Windows 2000

- 2001 October Microsoft Windows X P Home Edition & Professional
- 2002 September Microsoft Windows XP SP1

- 2003 February Microsoft Windows XP SP1a

- 2003March Microsoft Windows Server 2003

- 2004 August Microsoft Windows XP SP2

- 2006 Nov, 2007 Jan  Microsoft Windows Longhorn

2934$303c0 Microsoft Windows XP (OS) o3 2$:e§(03a5(¢5(8: Internet
Explorer 7, Microsoft Office 2007 3, WindowsMediaPlayer 11 o302 8oSmgesonds),
®(g¢ad: version gp: (¢d030lonadn

G¢: Microsoft Windows X P4, capg§:00 286892 ealoon 050.p@ coes (g5 83:
0 JGE D [gyog(ﬂ o0 c;q]:ﬁ%:og)qooo c;epé:or:) a%éaaeoT%,ﬂ o%é:@éqp:aaeoTogémé:
£02p50l00S1 poEd F6q),c0E g EEGPIe0 600520000050l S I

0C:8:6046 ©03¢800 DOS (Disk Operating System) 056 a30leoxi opo 956m
000E8: MS-DOS 1.0, 034029680965 m0gn(05:0303 0feqpa3doy 8a5m§esond
Readum B(Biogud e30E(gédclonudi oprs 9580qpimad MS-DOS 0564003

N N N ¢ o ¢ c_o N N < < <
CQ@C\?OG@@@: OCZ?Z@‘D:?O)O% ('YR:G[;)OC:COOQ@C: @@O']O’)OJII
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2060500603 058005

R eod E§0depyd coopar aa6edogPIad elogpecn adsoncdlondigidlod Character Map
06 60258 pdupCloncdiegnod Auto Correct ¢acopSs[afioné copSoon: dloncbipoen 'deg'
aBq€ Auto Correct on 2060b00 '_°' 03 e[gpéieuig€esant [§dl ooudi coodeogen og§eodd
500 deg o8 §05q¢ 500° a3e[gpaqecdzeon: 500 ° 3 [ogps0 008 0g0(epeGs eldlonudi 338
320905656p00800503(g§g0desq donudie§on§adoqgn elgpiod o5 E elgompieudlabaps

coné qéaao% :@Lor:) ©08650065m e'écrgméﬁc;aopé q. Word @é(ﬂ aS§eusi 68905
oI we(rs)cnecozeog(f?’ ogrﬁé:oo crahs,c;orySor%_ 8000703, C\é&?(ﬂ oS Insert\

Symbol §p5:03 a3:(03p30ln §(8: cguScladéensSn

S Document! - Microsoft Word

L | Symbols | Sgecial Characters |

= = Syl Eort: | (rormal tet) v Subret: |Latin-] -
e | [ p[Q[R[s[T|[U[v[W[x[Y[Zz|[[([\[1]~]_2
ﬁ'm“; ‘la|bfc|d|e|f|g|h|i|j|k|{l|m|n|o
plalr|s|t|o|v|w|x|y|z|{|]||}|~
i[e[e[=]¥[{]s["Te]*[]~]-[o[ T,

4 Becently used symboks:
r €|£|¥|o|®[™+|#|<|>|+|x|o|u|a|B

2 DEGREE SIGN Character code: 0080 from: |Unicode (hex) w
sa[@>ws
S e R Satout Key... | Shortout hey: Cirledd, Space

mcx?:eogtﬁ o&eeo:eo:eﬁ co‘éé]

og$e20p5 Microsoft's Word ogé [g§enengps §odecs §dlonud B8 §05epoge encdqp:a?
;c3zee0qp0d 'spellchecker' cpbeoiomndjdese)(gEagtiopt 328eepCadEigp:(gpd es0n0dd
00051 88c300pSen 32934 spellchecker o8 8o5conqEdlondi [girpbede o’ 5pSsc0diqp:ad
eqgeorden

o@a% eag})8o§ooo:eh§ @p_é:coé:eﬂo:go ﬁqlcﬂo:)osn oooeq,é:coé:ooé Word cr%
gSaoo:o (Menu) Tools>L anguage>Set language... o3 egguSoli odaes| ‘Language
dialogbox eolaxofB: gE:0p¢ ‘Do not check spelling or grammar' o3 check apSedosal

303008pS:¢o (Menu) Format > Stylesand Formatting... o3 g&agi€ paoo0S eon:
og¢ Styles and Formatting (pane) colaooclenSi géze New Style... of ccosad
305(5¢:(s¢ New Style(diadogbox) eolaooolepSi g€z 90050005 eaanndels§ Format
orcii or)coac)cx?(c) gf:cx%cﬁ@: qé:qf Language...o% ooéégéc\%(faohl [ qé:ogé oooeaaq]crgqp(fn%
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Page 1 Sec |

11
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: 3

4

. m...

A

tn1 Coll

Aarnbic (Algeria)
#arsbic (Bshwrain}

The speller and other proofing tooks atomaticaly
ussa chetionaias of the selected language, I

[] Datect larwuunge automaticaly

(o) o) (o= ]

-

E3
®

¥

dialog box gj: ecTaooo gé:o3¢ 'Do not check spelling or grammar’ o8 check opd

Sosdl

onoBuomyedaee (Menu) Tools> Options... o3 ¢&(8: colaneann boxe Spelling

& Grammar o3 clgoé:adascli gE:e Spelling §, 0o5a00520p3 329105403 80503¢:m)

c;g:s”oS@: checkc\?&ﬂ I

Microsoft Word ¢, format eop

0R$60358,805mescpd Word 3Eeogen format oy $ésad:qjed cogeed smiadiod [§Eeot
algpE:cdqEiloncdzaog:oofgé oohoBad0d0n upaonial enaxieaod 0683E32[gb opsupcised
ogl§6025 6|03 05a3 format eogd oopdesonahooiom eoggdlonud Fslecgn? oodslonpSsy

§E:qEdonud

| agreemant - Microsoft Word

P B Yew et Foms Jock Tabe Wedow beb

soE>wg
Page | Sec 1
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qoloouSi §odSmQesopd Word 20004, e§0053E:000500503 VErsioneogen aa0g0
o0 ega:8Ecloudi cenlql elgpéiadqiEod 03503 egigiuduli aniad:al elund:qtad
co%p CTRL+A (SelectAll) o3 eg:goScln (8:q¢ CTRL+SHIFT+N (Apply thenormal
style) o3 &6c305cli Format cog sao:cd: q&:agoiclad§endi sleoeny font size, font
styles, oog), ®3j05e0z0360% ee(@ac:§Sologen GE: c6:8§:4005000503 3620:805

o <
eq:ooo:ooo ﬂ(;lO’)ODII

Microsoft equation ¢ coogameay o[gedd

og$eond Word cd¢> Microsoft Equation of g€a8qeoecd gEscoogarn (symbols) gpsa?
[geoo:dh 920503 3a¢sa[o3p€ [§66120p503 olggEsevteonddlonddi

Equations o8 eup05 symbolsgp:aopS Microsoft Officecsopéoapbeodon a(8:
olaxooy Microsoft Equation (function) (gdcloooSi gé:03 ¢éep Insert > Object...o
ods0¢ Microsoft Equation o3 qpSclonudi eendqé agsqyomen Gé: Microsoft
Equation o3 ¢¢ a8 qeaddcopS: symbols qp: [geconiomm ooad:mdj:aeen: (font)
a3es§070l0SI 6130305 @o0dimd]:aen:on Times New Roman (séoloroSi

o0cd:3264 (05(08E8 p S: Microsoft Equationo? ¢¢a3o5(8: eolauooy toolbar
colon Style> Define... o3 ¢¢[B: seg0(0000:03 dm03S: TimesNew Romaneocd:qp:ad
e[gaé:eozoli sloeqaéeory Microsoft Officeo’ (0§orE(o3pgol

Styles E]

Style Font Character Format
Bold  [talic
Text........ | Times New Roman [ (m [
Function.. . . ... | Times New Roman =l Ezs |
Variable. . . . .. | Times New Roman ] m [
LC. Greek. .. .. | Symbol ~ - W
U.C. Greek . .. .. |Symbol ~l r r
Symbol . ... | Symbl S| m
Matiisector . . . | Times New Roman =l ¥
Number. .. .... | Times New Roman [ ml (m
Language:
Text style IAn_l,l LI
Other styles I.b.ny Ll
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:dmeagpod Save apdeu:§donud

Microsoft Word ¢ 3€a3 sac3macagqpod Save cpdeoionudad a8qclonudi GE:a3 9005c8
§588E€dkoocn

(r%oSe@cxPécx?(Se@of) (%5005(03&7% e@)oam Savec\380§ BeYBMIE 600o¢:0l
on0di Microsoft Wordeo ssgclopdcéiodaeogns SaveaySeo:0n0503 324§0200503,
o3 [0€q/¢§p Tool > Options... gondso¢ Save (tab) o3 géaSaSoli gE:opé auto-
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